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RESUMO 
 
 

O desgaste de ferramentas de corte é um fator determinante na eficiência dos processos 

de usinagem, influenciando a vida útil da ferramenta, a qualidade da peça e os custos 

industriais. Métodos tradicionais de avaliação, como medições lineares e inspeção visual, 

podem apresentar subjetividade e baixa reprodutibilidade. Diante disso, este trabalho 

propõe uma metodologia objetiva e acessível para a quantificação da área de desgaste 

em ferramentas de metal duro revestidas, utilizando o software ImageJ e técnicas de 

processamento digital de imagens. Foram analisadas micrografias de MEV provenientes 

do estudo de Ávila (2011), referentes a ferramentas K10 revestidas com CrAlN em duas 

composições: CrAlN-AA (alto teor de alumínio) e CrAlN-BA (baixo teor de alumínio). As 

imagens, obtidas nos tempos de usinagem de 2, 4, 6 e 8 minutos, foram tratadas por três 

métodos: medição manual, limiarização automática (threshold) e um método híbrido 

desenvolvido neste trabalho. Este último combina a seleção manual da região de 

interesse com a segmentação automática, proporcionando maior precisão e consistência 

nas leituras. Os resultados indicaram aumento progressivo da área desgastada para 

ambos os revestimentos, com diferenças relevantes entre os métodos. O método manual 

apresentou maior variabilidade, enquanto o método semiautomático mostrou boa 

repetibilidade, porém sensibilidade a irregularidades de brilho. O método híbrido 

destacou-se como a abordagem mais robusta, permitindo análises mais padronizadas. 

Observou-se ainda que, diferentemente da métrica linear VB utilizada por Ávila, a 

quantificação por área revelou comportamento mais estável para o CrAlN-AA em maiores 

tempos de corte, demonstrando que métricas distintas podem levar a interpretações 

complementares do desempenho dos revestimentos. Conclui-se que a metodologia 

proposta é eficaz, reprodutível e aplicável em estudos acadêmicos e industriais, 

ampliando as possibilidades de análise quantitativa do desgaste de ferramentas. 

 
 
Palavras-chave: Desgaste de flanco, tratamento de imagens, ImageJ, torneamento. 
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RESUMEN 
 
 

El desgaste de las herramientas de corte es un factor determinante en la eficiencia 

de los procesos de mecanizado, ya que influye en la vida útil de la herramienta, la 

calidad de la pieza y los costos industriales. Los métodos tradicionales de 

evaluación, como las mediciones lineales y la inspección visual, pueden presentar 

subjetividad y baja reproducibilidad. Ante esto, este trabajo propone una metodología 

objetiva y accesible para cuantificar el área de desgaste en herramientas de metal 

duro recubiertas, utilizando el software ImageJ y técnicas de procesamiento digital 

de imágenes. Se analizaron micrografías de SEM procedentes del estudio de Ávila 

(2011), referidas a herramientas K10 recubiertas con CrAlN en dos composiciones: 

CrAlN-AA (alto contenido de aluminio) y CrAlN-BA (bajo contenido de aluminio). Las 

imágenes, obtenidas en tiempos de mecanizado de 2, 4, 6 y 8 minutos, se trataron 

mediante tres métodos: medición manual, umbralización automática (threshold) y un 

método híbrido desarrollado en este trabajo. Este último combina la selección 

manual de la región de interés con la segmentación automática, lo que proporciona 

una mayor precisión y consistencia en las lecturas. Los resultados indicaron un 

aumento progresivo del área desgastada para ambos recubrimientos, con 

diferencias relevantes entre los métodos. El método manual presentó una mayor 

variabilidad, mientras que el método semiautomático mostró una buena repetibilidad, 

pero sensibilidad a las irregularidades de brillo. El método híbrido se destacó como 

el enfoque más robusto, permitiendo análisis más estandarizados. También se 

observó que, a diferencia de la métrica lineal VB utilizada por Ávila, la cuantificación 

por área reveló un comportamiento más estable para el CrAlN-AA en tiempos de 

corte más largos, lo que demuestra que métricas diferentes pueden llevar a 

interpretaciones complementarias del rendimiento de los recubrimientos. Se 

concluye que la metodología propuesta es eficaz, reproducible y aplicable en 

estudios académicos e industriales, ampliando las posibilidades de análisis 

cuantitativo del desgaste de herramientas. 

 
 
Palabras clave: Desgaste de flanco, tratamiento de imágenes, ImageJ, torneado. 
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ABSTRACT 
 
 

The wear of cutting tools is a determining factor in the efficiency of machining 

processes, influencing tool life, part quality, and industrial costs. Traditional 

evaluation methods, such as linear measurements and visual inspection, can be 

subjective and have low reproducibility. Given this, this study proposes an objective 

and accessible methodology for quantifying the wear area in coated carbide tools, 

using ImageJ software and digital image processing techniques. SEM micrographs 

from the study by Ávila (2011) were analyzed, referring to K10 tools coated with 

CrAlN in two compositions: CrAlN-AA (high aluminum content) and CrAlN-BA (low 

aluminum content). The images, obtained at machining times of 2, 4, 6, and 8 

minutes, were processed using three methods: manual measurement, automatic 

thresholding, and a hybrid method developed in this study. The latter combines 

manual selection of the region of interest with automatic segmentation, providing 

greater accuracy and consistency in readings. The results indicated a progressive 

increase in the worn area for both coatings, with significant differences between the 

methods. The manual method showed greater variability, while the semi-automatic 

method showed good repeatability but sensitivity to gloss irregularities. The hybrid 

method stood out as the most robust approach, allowing for more standardized 

analyses. It was also observed that, unlike the linear VB metric used by Ávila, 

quantification by area revealed more stable behavior for CrAlN-AA at longer cutting 

times, demonstrating that different metrics can lead to complementary interpretations 

of coating performance. It is concluded that the proposed methodology is effective, 

reproducible, and applicable in academic and industrial studies, expanding the 

possibilities for quantitative analysis of tool wear. 

 
 
Key words: Flank wear, image processing, ImageJ, turning. 
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1. INTRODUÇÃO 

1.1 CONTEXTUALIZAÇÃO DO PROCESSO DE TORNEAMENTO 

O processo de torneamento é uma das operações de usinagem por remoção de 

cavaco mais relevantes e difundidas na indústria, sendo essencial para a produção de 

componentes de alta qualidade para múltiplos setores industriais (SOUSA et al., 2021). 

O processo consiste na remoção de material de uma peça em rotação por meio de uma 

ferramenta de corte, gerando superfícies com alta precisão dimensional e acabamento 

controlado (SANTOS, 2017). Contudo, a busca por materiais com melhores 

propriedades mecânicas, como o ferro fundido nodular FE 45012 (perlítico-ferrítico), 

impõe novos desafios ao processo. Este material, apesar de suas vantagens, possui 

uma usinabilidade considerada difícil, caracterizada pela geração de elevadas 

temperaturas na zona de corte e por uma forte tendência ao desgaste da ferramenta, 

especialmente em usinagem a seco (ÁVILA, 2011). Para superar essas condições 

severas, o desenvolvimento de ferramentas de corte avançadas é fundamental. A 

solução moderna reside no uso de ferramentas de metal duro (WC-Co) com 

revestimentos cerâmicos nanoestruturados, como os sistemas ternários (Ti1-xAlx)N e 

(Cr1-xAlx)N, aplicados por técnicas como a Deposição Física de Vapores (PVD) 

(ÁVILA, 2011; SOUSA et al., 2021a).  

 

1.2 IMPORTÂNCIA DA ANÁLISE DE DESGASTE EM FERRAMENTAS DE CORTE 

O desgaste da ferramenta é um fenômeno inevitável que limita a produtividade e 

impacta diretamente os custos e a qualidade na usinagem (ALEXANDRE, 2011). No 

torneamento do ferro fundido nodular, o controle do desgaste é particularmente crítico, 

pois sua progressão afeta a integridade superficial da peça e eleva as forças de 

usinagem (ÁVILA, 2011). O monitoramento do desgaste de flanco (VB), que ocorre na 

principal superfície de folga da ferramenta, é a prática mais comum para determinar o 

fim da vida da ferramenta (SANTOS, 2017). Os mecanismos predominantes nesta 

usinagem são a abrasão, causada pelas fases mais duras da microestrutura (como a 

perlita), e a adesão, potencializada pelas altas temperaturas (ÁVILA, 2011). Uma 

análise precisa desses fenômenos é crucial, porém os métodos tradicionais de 
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medição, baseados em microscopia óptica, são manuais, demorados e altamente 

dependentes da interpretação do operador, o que introduz subjetividade e 

inconsistência nos resultados (ALEXANDRE, 2011; ALBERTO, 2014). 

 

1.3 JUSTIFICATIVA DA ESCOLHA METODOLÓGICA 

Os métodos tradicionais para quantificação do desgaste, como o uso de 

microscópios ópticos com paquímetros digitais ou projetores de perfil, apesar de 

estabelecidos, apresentam limitações significativas. São processos manuais, 

demorados, que exigem operadores experientes e estão sujeitos a erros de medição e 

à subjetividade da interpretação humana (ALEXANDRE, 2011; ALBERTO, 2014). Essa 

falta de repetibilidade e precisão dificulta a comparação rigorosa entre diferentes testes 

e condições de usinagem. 

Diante dessas desvantagens, sistemas baseados em visão computacional e 

tratamento digital de imagens representam uma alternativa eficiente e já estabelecida 

(ALEXANDRE, 2011). A análise de imagens permite automatizar a detecção e a 

medição da área de desgaste, oferecendo resultados mais rápidos, objetivos, precisos 

e repetitivos (ALBERTO, 2014; LIZARELLI et al., 2007). Este trabalho propõe o 

desenvolvimento de uma metodologia para a quantificação do desgaste utilizando o 

software ImageJ. A escolha desta plataforma se justifica por ser uma ferramenta de 

domínio público, amplamente validada na comunidade científica e que possui um vasto 

conjunto de recursos para análise de imagens. O ImageJ permite a criação de rotinas 

automatizadas (macros) para segmentar a região de interesse e extrair parâmetros 

geométricos, representando uma solução de custo zero, acessível e de fácil 

implementação para uma análise de desgaste mais confiável e detalhada (LIZARELLI 

et al., 2007). Nesse sentido, este trabalho busca estabelecer um procedimento 

padronizado, capaz de medir com precisão a área de desgaste de flanco (em μm2), 

reduzindo a subjetividade inerente aos métodos lineares tradicionais e garantindo a 

repetibilidade entre medições. Para isso, foram investigadas e comparadas três 

abordagens metodológicas: manual, semiautomática (Limiarização "Threshold") e 

híbrida, com graus crescentes de automação, visando definir o método mais eficiente 

para esta aplicação. 
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2. OBJETIVOS  

 

2.1 OBJETIVO GERAL 

Desenvolver uma metodologia de quantificação da área de desgaste de flanco 

utilizando o software ImageJ, aplicada à análise de desempenho de ferramentas de 

metal duro (classe K10) revestidas com CrAlN (com variados teores de Alumínio) no 

torneamento de Ferro Fundido Nodular FE 45012. 

 

2.2 OBJETIVO ESPECÍFICO 

• Estruturar um procedimento de medição no software ImageJ, por meio da criação 

de uma macro, capaz de identificar, isolar e medir a área de desgaste de flanco a 

partir de imagens digitais de ferramentas utilizadas no torneamento de Ferro 

Fundido Nodular FE 45012, comparando técnicas manuais e semiautomáticas 

(limiarização) para definir o método mais objetivo e repetível de medição de área; 

• Aplicar a metodologia desenvolvida para identificar, isolar e quantificar a 

evolução da área de desgaste de flanco em micrografias de ferramentas 

revestidas com CrAlN-AA (Alto Alumínio: CrAlN-AA) e CrAlN-BA (Baixo Alumínio: 

CrAlN-BA); 

• Analisar comparativamente o desempenho dos dois tipos de revestimento (AA 

vs. BA) na usinagem de ferro fundido nodular, utilizando os resultados de 

evolução da área de desgaste (mm2) em função do tempo de corte. 
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3. REVISÃO BIBLIOGRÁFICA 

 

3.1. FERRAMENTAS DE CORTE E MATERIAIS COMUMENTE UTILIZADOS 

 

A seleção do material da ferramenta de corte é um dos fatores mais críticos para 

o sucesso de uma operação de usinagem, impactando diretamente a vida útil da 

ferramenta, a qualidade da peça e a produtividade do processo. Os materiais devem 

possuir um conjunto de propriedades que inclui alta dureza (especialmente a quente, 

para resistir à deformação plástica), tenacidade para suportar choques mecânicos e 

térmicos, resistência ao desgaste e estabilidade química para não reagir com o material 

da peça (SOARES, 2013). 

O metal duro (WC-Co) é o material mais versátil e utilizado na usinagem de aços, 

oferecendo uma excelente combinação de dureza e tenacidade. Trata-se de um 

compósito metal-cerâmico, formado por partículas duras de Carboneto de Tungstênio 

(WC) sinterizadas em uma matriz metálica ligante, geralmente Cobalto (Co) (ÁVILA, 

2007; SAKETI et al., 2019). A variação no tamanho de grão do WC e na proporção de 

Cobalto permite uma ampla gama de classes, otimizadas para diferentes aplicações, 

desde o desbaste pesado até operações de acabamento fino (SAKETI et al., 2019). 

As ferramentas de cerâmica, como as de óxido de alumínio (Al2O3) pura ou 

mista (com adição de Carboneto de Titânio - TiC), são conhecidas por sua excepcional 

dureza a quente, resistência à oxidação e estabilidade química, o que as torna ideais 

para a usinagem em altas velocidades de materiais como o ferro fundido (LIN et al., 

2020; SOARES, 2013). Sua principal limitação é a baixa tenacidade, que as torna 

suscetíveis a fraturas por impacto ou variações bruscas de temperatura (LIN et al., 

2020). 

Sendo o segundo material mais duro conhecido, o Nitreto Cúbico de Boro (CBN) 

é a escolha preferencial para o torneamento de aços endurecidos (com dureza acima 

de 45 HRC), ferros fundidos e superligas à base de níquel. Sua grande vantagem é a 

alta inércia química em relação a materiais ferrosos, evitando o desgaste por difusão 

que ocorre com ferramentas de diamante nessas aplicações (SOUSA et al., 2021a; 

SOARES, 2013). 
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3.2 REVESTIMENTOS BINÁRIOS E TERNÁRIOS EM FERRAMENTAS DE CORTE 

 

Para aprimorar o desempenho das ferramentas de metal duro, aplicam-se 

revestimentos cerâmicos finos (de 2 a 5 µm), comumente por processos de Deposição 

Física de Vapores (PVD) (ÁVILA, 2007). Esses revestimentos multifuncionais atuam 

como uma barreira que aumenta a dureza superficial, a resistência ao desgaste, a 

estabilidade térmica e reduz o atrito entre a ferramenta e o cavaco (SOUSA et al., 

2021a; ÁVILA, 2007).  

Historicamente, o Nitreto de Titânio (TiN) foi o primeiro revestimento a se 

popularizar, oferecendo boa proteção contra desgaste abrasivo. No entanto, a 

necessidade de usinagem em maiores velocidades e temperaturas exigiu a evolução 

para sistemas ternários (adição de um terceiro elemento), visando principalmente a 

estabilidade térmica (ÁVILA, 2007; ARULKIRUBAKARAN; SENTHILKUMAR, 2017). 

Nesse contexto, a adição de Alumínio (Al) aos nitretos de metais de transição provou 

ser fundamental. Em revestimentos como o (TiAl)N, o alumínio migra para a superfície 

em altas temperaturas e forma uma camada passiva de óxido de alumínio (Al2O3). 

Essa camada atua como um isolante térmico e uma barreira contra a difusão, 

protegendo a ferramenta da oxidação severa (MOGHADDAM et al., 2021; HE et al., 

2022). 

Evoluindo a partir do TiAlN, o sistema Nitreto de Cromo-Alumínio (CrAlN) foco 

deste trabalho, tem ganhado destaque na usinagem de materiais ferrosos. A 

substituição do Titânio pelo Cromo confere ao revestimento uma resistência à oxidação 

superior e uma menor afinidade química com o ferro, o que reduz a tendência ao 

desgaste por adesão (cratera) (SOUSA et al., 2021a; TOTOLICI et al., 2024). 

Um fator crítico no desempenho do CrAlN é a estequiometria, ou seja, a 

proporção entre Cromo e Alumínio: 

• Altos teores de Alumínio tendem a aumentar a dureza a quente e a resistência à 

oxidação, favorecendo a formação da camada protetora cerâmica.  

• Altos teores de Cromo podem favorecer a tenacidade e reduzir as tensões 

residuais do revestimento (HE et al., 2022; ÁVILA, 2011).  
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O estudo de referência deste trabalho (ÁVILA, 2011) explora justamente essas 

variações, analisando o comportamento de revestimentos com diferentes 

balanceamentos de Alumínio, designados como CrAlN-AA (Alto Alumínio) e CrAlN-BA 

(Baixo Alumínio), para determinar a configuração mais eficiente no torneamento do ferro 

fundido nodular. 

 

3.3 TIPOS DE DESGASTE 

Por definição da norma ASTM G40 (2015) o desgaste engloba a perda 

progressiva de material ou modificação de superfície de um objeto devido ao 

movimento relativo entre esta superfície e uma ou outras mais substâncias em contato. 

Sendo o desgaste uma das formas mais severas de degradação dos materiais 

(MARTINEZ, 2004). A resistência ao desgaste é a habilidade do material de ter uma 

vida útil relativamente elevada quando submetido aos vários tipos de mecanismos de 

desgaste: ataque (contato físico direto), desgaste por fusão, oxidação/difusão e 

plasticidade (DIAS, 2007). 

Existe uma série de fatores que influenciam no desgaste do material, dentre eles 

suas características, condições de operação, variáveis geométricas e condições 

ambientais (BHUSHAN, 2013). Os mecanismos de desgaste podem ser classificados 

em quatro principais grupos: desgaste adesivo, desgaste abrasivo, desgaste erosivo e 

fadiga superficial (BUDINSKI, 1988). A Tabela 1 resume os 4 diferentes mecanismos de 

desgaste. 

 

Tabela 1 Mecanismos de desgaste 

Mecanismo de desgaste Descrição 

Adesivo 

Transferência de material de uma superfície a outra. As 

partículas que são removidas de uma superfície são 

permanentemente ou temporariamente aderidas à 

superfície do outro material. 

Abrasivo 
Ocorre devido a partículas ou protuberâncias duras 

forçadas ao longo de uma superfície sólida. 

Erosivo Perda de material da superfície que resulta do impacto 
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repetitivo de pequenas partículas sólidas sob uma 

superfície. 

Fadiga superficial 
Danos superficiais causados por um contato de rolamento 

repetido. 

Fonte: ASM, 2001; Stachowiak, 2005. 

 

Como mecanismo de desgaste, a adesão é entendida pela formação e quebra de 

ligações interfaciais, as quais são arrancadas durante o movimento tangencial do 

processo de corte. A formação da adesão é extremamente dependente da interação 

atômica entre os materiais que formam o sistema tribológico (GAHR, 1987; TRENT; 

WRIGHT, 2000).  

A abrasão, por sua vez, ocorre quando partículas presentes no material usinado, 

ou até mesmo um material intermediário (formado pela adesão sobre a face da 

ferramenta, por exemplo), penetram no material da ferramenta e, com o movimento 

tangencial do processo, produzem ranhuras no material desgastado (KLOCKE; KÖNIG, 

2008; GAHR, 1987). As Figuras 1 e 2 demonstram o esquema do mecanismo de 

desgaste abrasivo e adesivo respetivamente. 

Figura 1 Mecanismos de desgaste abrasivo 

 

a. Por corte, b. Fratura, c. Fadiga, d. Retirada de grão.  

Fonte: Stachowiak, 2005. 
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Figura 2 Processo de transferência de metal por adesão 

 

Fonte: Stachowiak, 2005. 

 

O desgaste por difusão é um mecanismo termicamente ativado, regido pelas leis 

da termodinâmica, que se torna o modo de desgaste dominante em temperaturas 

elevadas, tipicamente acima de 700°C, na interface cavaco-ferramenta. O processo é 

impulsionado pela afinidade química e pelos gradientes de concentração entre os 

materiais em contato (ferramenta e peça). Átomos de elementos presentes na 

ferramenta, como o cobalto (Co) que atua como ligante em ferramentas de metal duro, 

ou o tungstênio (W), podem se difundir para o material do cavaco, que atua como um 

sumidouro para esses elementos. De forma simultânea, átomos do material usinado, 

principalmente o ferro (Fe) no caso de aços, difundem-se para a superfície da 

ferramenta.  

Essa migração atômica mútua resulta em uma alteração da composição química 

da camada superficial da ferramenta. A perda de cobalto, por exemplo, leva ao 

enfraquecimento da matriz que sustenta os carbetos de tungstênio, reduzindo sua 

dureza a quente e sua tenacidade. A penetração de ferro pode formar fases 

intermetálicas frágeis, fragilizando a aresta de corte e acelerando drasticamente a taxa 

de desgaste global (SAKETI et al., 2019; ÁVILA, 2007). 

A oxidação é um mecanismo de desgaste de natureza química, potencializado 

pelas altas temperaturas na zona de corte e pela interação da ferramenta com o 

oxigênio presente no ambiente (ar e água). O processo leva à formação de camadas de 

óxido na superfície da ferramenta, que por serem geralmente frágeis e pouco 

aderentes, são facilmente removidas pelo fluxo do cavaco, expondo novo material a ser 

oxidado. Embora os fluidos de corte possuam aditivos antioxidantes, a falta de 

manutenção e conservação adequada desses fluidos na máquina pode comprometer 

sua função protetora, contribuindo para a aceleração do desgaste por oxidação (DINIZ; 
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MARCONDES; COPPINI, 2013). A Figura 3 relaciona a evolução dos mecanismos de 

desgastes com o aumento da temperatura do processo: 

Figura 3 Diagrama de mecanismos de desgaste versus temperatura de corte 

 

Fonte: Machado et al., 2011. 

 

3.4 MECANISMOS DE FALHA E VIDA ÚTIL DE FERRAMENTAS 

A vida útil da ferramenta é definida como o tempo de corte durante o qual ela 

ópera de forma eficaz e segura, produzindo peças com a qualidade especificada. O fim 

da vida é determinado quando o desgaste atinge um limite predefinido, conhecido como 

critério de fim de vida (ÁVILA, 2007). A Figura 4 mostra a representação esquemática 

da forma do desgaste em ferramentas que possuem geometria definida, conforme a 

norma DIN ISO 3685:1993(KLOCKE; KÖNIG, 2008; GAHR, 1987). 
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Figura 4 Representação esquemática da forma do desgaste em ferramentas que possuem geometria 
definida 

 

Fonte: Klocke; König, 2008. 

 

A Figura 4 fornece informações bidimensionais do desgaste – profundidades e 

comprimentos. Porém, não há descrição sobre informações como a área afetada, ou o 

volume de material removido da ferramenta (GAHR, 1987). Os principais parâmetros 

utilizados para avaliação do desgaste são: desgaste de flanco (VB) e desgaste de 

flanco médio (VBB); deslocamento do gume no sentido do flanco (SVα) e da face (SVγ); 

profundidade da cratera (KT) e afastamento médio da região mais profunda da cratera 

(KM), (GAHR, 1987). 

Os principais mecanismos de falha são: 

• Desgaste de Flanco: Desgaste gradual e uniforme na superfície de folga 

principal, causado majoritariamente por abrasão. É a forma mais desejável de 
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desgaste por ser progressiva e previsível (ÁVILA, 2007; HRECHUK; BUSHLYA, 

2023). 

• Desgaste de Cratera: Formação de uma cavidade na face de ataque, onde a 

temperatura e a pressão são máximas, causada principalmente por difusão e 

desgaste químico (LI et al., 2019). 

• Lascamento (Chipping) e Fratura: Falhas súbitas e catastróficas da aresta de 

corte, geralmente causadas por sobrecarga mecânica, instabilidades ou fadiga 

térmica (PATEL et al., 2020). 

 

3.5 TÉCNICAS DE CARACTERIZAÇÃO DE DESGASTE 

• Microscopia Óptica: É a técnica mais comum para medições dimensionais do 

desgaste, como o VBmax. Contudo, é um método manual, sujeito à interpretação 

do operador e com limitações de resolução e profundidade de foco 

(ALEXANDRE, 2011; SOARES, 2013). 

• Microscopia Eletrônica de Varredura (MEV): Essencial para a análise 

morfológica detalhada das superfícies desgastadas. Suas imagens de alta 

resolução e grande profundidade de campo permitem a identificação clara dos 

mecanismos de desgaste, como sulcos de abrasão, material aderido e 

microtrincas (ÁVILA, 2007; SOARES, 2013). 

• Espectroscopia de Energia Dispersiva (EDS): Acoplada ao MEV, a EDS é uma 

técnica de microanálise que identifica os elementos químicos presentes em uma 

área específica da amostra, sendo crucial para confirmar a transferência de 

material por adesão ou difusão (ÁVILA, 2007; SAKETI et al., 2019). 

• Análise de Imagens Digitais: Utiliza algoritmos e softwares para processar 

imagens obtidas por microscopia, permitindo a medição automática, objetiva e 

repetitiva de parâmetros como área, perímetro e forma do desgaste (LIZARELLI 

et al., 2007; HRECHUK; BUSHLYA, 2023). 

 

3.6 APLICAÇÕES E LIMITAÇÕES DO MEV NA ENGENHARIA DE MATERIAIS 

O MEV é um dos mais versáteis instrumentos disponíveis para a observação e 

análise de características microestruturais de objetos sólidos. A principal razão de sua 
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utilidade é a alta resolução que pode ser obtida quando as amostras são observadas; 

valores da ordem de 2 a 5 nanômetros são geralmente apresentados por instrumentos 

comerciais, enquanto instrumentos de pesquisa avançada são capazes de alcançar 

uma resolução melhor que 1 nm (NAGATANI et al. 1987). 

A Microscopia Eletrônica de Varredura (MEV) é uma técnica fundamental na 

Engenharia de Materiais para o diagnóstico de mecanismos de falha, sendo 

particularmente poderosa na investigação do desgaste de ferramentas de corte. A sua 

capacidade de gerar imagens com alta resolução e elevada profundidade de campo 

permite uma análise detalhada das complexas topografias e alterações composicionais 

que surgem nas superfícies desgastadas (GOLDSTEIN et al., 2003). A eficácia do MEV 

para este tipo de análise reside na utilização de diferentes sinais gerados pela interação 

do feixe de elétrons com a amostra, que produzem imagens com informações distintas 

e complementares. 

 

3.6.1 Análise Topográfica por Elétrons Secundários (SE) 

As imagens formadas por Elétrons Secundários (SE) são extremamente sensíveis à 

topografia da superfície da amostra. Este modo de operação é, portanto, essencial para 

a identificação morfológica dos mecanismos de desgaste. Por meio das imagens de SE, 

é possível visualizar com clareza feições como sulcos e riscos característicos do 

desgaste abrasivo, o arrancamento de material e a formação de crateras resultantes do 

desgaste adesivo, e a nucleação de microtrincas associadas à fadiga térmica ou 

mecânica (DEDAVID; GOMES; MACHADO, 2007). 

 

3.6.2 Análise Composicional por Elétrons Retroespalhados (BSE) 

As imagens de Elétrons Retroespalhados (BSE) são geradas a partir de elétrons do 

feixe primário que são espalhados pela amostra. A intensidade deste sinal é 

diretamente proporcional ao número atômico (Z) médio da região analisada, o que gera 

um forte contraste composicional (GOLDSTEIN et al., 2003). Para a análise de 

ferramentas desgastadas, as imagens de BSE são cruciais para:  

• Identificar a transferência de material: É possível distinguir claramente o material 

da peça (geralmente de baixo Z, como ligas de aço ou alumínio) aderido à 
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superfície da ferramenta (composta por elementos de alto Z, como tungstênio e 

titânio), confirmando o mecanismo de adesão. 

• Detetar alterações químicas: Fenômenos como a oxidação ou a formação de 

outras fases na superfície da ferramenta podem ser detectados devido à 

variação no número atômico médio da região afetada (GOODHEW; 

HUMPHREYS; BEANLAND, 2001). 

A análise combinada das imagens de SE e BSE permite, portanto, uma 

correlação direta entre a morfologia de uma feição de desgaste e a sua natureza 

química, fornecendo um diagnóstico preciso e completo dos fenômenos que levaram à 

degradação da ferramenta (GOLDSTEIN et al., 2003). 

 

3.7 USO DO IMAGEJ NA QUANTIFICAÇÃO DE IMAGENS 

O ImageJ é uma plataforma de software de domínio público, desenvolvida pelo 

National Institutes of Health (NIH) dos Estados Unidos, que se consolidou como uma 

ferramenta padrão para o processamento e análise de imagens científicas em diversas 

áreas do conhecimento (SCHNEIDER; RASBAND; ELICEIRI, 2012). Desenvolvido na 

linguagem de programação Java, o software é multiplataforma e possui uma arquitetura 

aberta, o que permite que sua funcionalidade seja expandida continuamente por uma 

vasta comunidade de usuários e desenvolvedores através de plugins e macros 

(COLLINS, 2007). 

O funcionamento do ImageJ baseia-se no princípio de tratar a imagem digital não 

apenas como uma representação visual, mas como uma matriz de dados quantitativos, 

onde cada pixel possui um valor de intensidade (nível de cinza). Essa abordagem 

permite que operações matemáticas e estatísticas sejam aplicadas à imagem para 

extrair informações objetivas que não são acessíveis por meio de uma simples inspeção 

visual (RUSS, 2011). Uma de suas capacidades centrais é a segmentação de imagem, 

um processo que visa particionar a imagem em suas partes constituintes, separando as 

feições de interesse (como partículas, fases microestruturais ou poros) do fundo da 

imagem. Frequentemente, isso é alcançado através de técnicas de limiarização 

(thresholding), onde um ou mais valores de intensidade de pixel são definidos como 

limites para isolar as áreas de interesse (SCHNEIDER; RASBAND; ELICEIRI, 2012). 
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Uma vez que as feições de interesse são isoladas, o ImageJ oferece um robusto 

conjunto de ferramentas para medições quantitativas, incluindo: 

I. Análise Morfométrica: Cálculo de parâmetros geométricos como área, perímetro, 

diâmetro, circularidade e fator de forma de partículas ou regiões. 

II. Medições Dimensionais: Ferramentas calibradas para medir comprimentos, 

ângulos e distâncias com precisão. 

III. Análise de Intensidade: Medição da densidade óptica, valores médios de cinza e 

plotagem de perfis de intensidade ao longo de uma linha. 

 

Na engenharia de materiais, o ImageJ se aplica de maneira extremamente 

eficiente para transformar as micrografias, como as obtidas por MEV, em dados 

quantitativos. Ele é amplamente utilizado para: 

I. Quantificação de Fases: Determinar a fração volumétrica de diferentes fases em 

uma microestrutura metálica ou cerâmica. 

II. Análise de Porosidade: Medir o tamanho, a distribuição e a porcentagem de 

poros em materiais sinterizados, compósitos ou revestimentos. 

III. Caracterização de Partículas: Analisar a distribuição de tamanho de pós ou 

partículas de reforço em uma matriz. 

IV. Quantificação de Desgaste: Medir a área de regiões que sofreram destacamento 

de material ou a densidade de microtrincas em uma superfície desgastada. 

Em suma, o ImageJ funciona como uma ponte entre a visualização qualitativa 

fornecida pela microscopia e a análise quantitativa exigida pela ciência dos materiais, 

permitindo a extração de dados numéricos objetivos a partir de imagens digitais, o que 

é essencial para a correlação rigorosa entre microestrutura e propriedades (COLLINS, 

2007; RUSS, 2011). 
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4. MATERIAIS E MÉTODOS 

A Figura 5 apresenta o fluxograma esquematizado com a sequência de 

desenvolvimento das etapas experimentais, facilitando a visualização e compreensão 

da metodologia adotada. 

Figura 5 Esquema da sequência do trabalho 

     

 

 

Versão Final Homologada
10/02/2026 15:14



 

16 

 

4.1 APLICAÇÕES E LIMITAÇÕES DO MEV NA ENGENHARIA DE MATERIAIS 

Este estudo foi desenvolvido como um caso metodológico, utilizando 

micrografias em formato .tif e dados experimentais provenientes do relatório técnico de 

pós-doutorado de Ávila (2011). A seguir, detalham-se os materiais e as condições que 

originaram as imagens analisadas. 

Material da Peça (Workpiece): O material usinado nos ensaios foi o Ferro 

Fundido Nodular, classe ABNT FE 45012. Este material apresenta uma microestrutura 

mista perlítico-ferrítica, combinando boa usinabilidade com propriedades mecânicas 

elevadas, características que justificam o estudo do desgaste da ferramenta durante o 

torneamento. 

Substrato e Geometria da Ferramenta: As ferramentas utilizadas foram 

insertas de metal duro (Carboneto de Tungstênio, WC) com ligante de Cobalto.  

• Composição: WC com 6% de Co (em peso).  

• Classe: ISO K10 (tenaz, indicada para ferros fundidos). 

• Geometria: Insertos quadrados sem furo central, especificação ISO SNGN 

120408 (aresta de 12,7 mm, espessura de 4,76 mm e raio de ponta de 0,8 mm). 

 

Características dos Revestimentos (CrAlN): O foco da análise recai sobre 

ferramentas revestidas com Nitreto de Cromo-Alumínio (CrAlN), depositadas via PVD. 

Foram analisadas duas variantes deste revestimento para verificar a influência do teor 

de Alumínio na resistência ao desgaste de flanco, conforme demonstrado no 

comparativo de desempenho da Figura 6. 

➢ CrAlN-AA (Alto Alumínio): Estequiometria (𝐶𝑟0,32𝐴𝑙0,68)𝑁 com 

espessura de 1,98 μm. 

➢ CrAlN-BA (Baixo Alumínio): Estequiometria (𝐶𝑟0,75𝐴𝑙0,25)𝑁 com 

espessura de 2,5 μm. 
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Figura 6 Evolução do desgaste de flanco máximo (VB max) em função do tempo para os revestimentos 
CrAlN-AA e CrAlN-BA. 

 

Fonte: Adaptado de Ávila, 2011. 

 

Além da geometria e do revestimento, a caracterização química da 

superfície desgastada (realizada originalmente via EDS - Espectroscopia de 

Energia Dispersiva) revela a interação entre o material da peça e a ferramenta.  

A Figura 7 ilustra o mapeamento de elementos após 8 minutos de corte, 

evidenciando as regiões de exposição do substrato e adesão de material. 
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Figura 7 Imagens de Raios X sobrepostas dos principais elementos do par tribologico 

 

Fonte: Adaptado de Ávila, 2011. 

 

Parâmetros de Ensaios (Condições de Corte): Os ensaios de torneamento 

cilíndrico externo foram realizados a seco. Os parâmetros mantidos constantes foram: 

• Velocidade de Corte (Vc): 200 m/min. 

• Avanço (f): 0,25 mm/rot. 

• Profundidade de Corte (Ap): 2 mm. 

 

Aquisição de Imagens (Tempos de Parada): O desgaste de flanco foi 

monitorado interrompendo-se o processo em intervalos pré-determinados. As imagens 

de Microscopia Eletrônica de Varredura (MEV) utilizadas neste TCC correspondem aos 

seguintes tempos de usinagem efetiva: 

• Tempos analisados (t): 2, 4, 6 e 8 minutos. 

• Configuração: As imagens possuem aumento de 70X e inclinação de 45°, 

permitindo a visualização clara da face de folga da ferramenta. A Tabela 2 
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resume as condições experimentais. 

Tabela 2 Imagens de Raios X sobrepostas dos principais elementos do par tribologico 

Material da peça 
Ferro Fundido Nodular, classe ABNT FE 45012 

(perlítico-ferrítico) 

Processo Torneamento a seco 

Substrato da ferramenta Metal duro (WC-6%Co) Classe K10 

Revestimentos analisados 

CrAIN com dois teores de aluminío 

i) CrAlN-AA: (Cr0,32Al0,68)N 
ii) CrAlN-BA: (Cr0,75Al0,25)N 

Espessura dos revestimentos 
i) CrAlN-AA: 1,98 μm 
ii) CrAlN-BA: 2,5 μm 

Condições de corte 
Profundidade de Corte (ap): 0,2 mm 

Avanço (f): 0,25 mm/rot 
Velocidade de Corte (vc): 200 m/min 

Tempos de usinagem analisados 

Foram escolhidos 4 tempos de estudo para 

coleta das imagens de MEV, com aumentos de 

70X, inclinação de 45⁰. 

t1: 2 min 
t2: 4 min 
t3: 6 min 
t4: 8 min 

Fonte: Adaptado de Ávila, 2011. 

 

Essa configuração de aquisição a 45º é estratégica para a metodologia 

de baixo custo, pois permite a visualização simultânea de dois mecanismos 

críticos de falha na mesma imagem digital. 

• Desgaste de Flanco (VB): Região de interesse primário deste trabalho, 

caracterizada visualmente pela perda de material e presença de 

ranhuras paralelas à direção de corte, típicas do mecanismo de abrasão 

mecânica descrito por Ávila (2007). 

• Desgaste de Cratera (KT): Localizada na face de ataque, apresentando 

uma morfologia côncava resultante de fenômenos termicamente 

ativados, como a difusão e a adesão, conforme detalhado por Li et al. 

(2019). 

A identificação clara dessas feições nas micrografias confirma a 

adequação das imagens para o processamento digital no software ImageJ, 

permitindo a segregação e quantificação das áreas desgastadas conforme as 

diretrizes de caracterização morfológica de ferramentas (HRECHUK; 
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BUSHLYA, 2023). 

Para a análise experimental, as micrografias foram organizadas 

cronologicamente para cada revestimento: 

• CrAlN-AA (Alto Alumínio): Imagens catalogadas de T1 a T4 (Figuras 8. 

A a D); 

• CrAlN-BA (Baixo Alumínio): Imagens catalogadas de T1 a T4 (Figuras 

9.  E a H). 

Figura 8 Micrografias de CrAIN-AA (Alto Alumínio) 

 

             Fonte: Ávila, 2011. 
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Figura 9 Micrografias de CrAIN-BA (Baixo Alumínio) 

 

           Fonte: Ávila, 2011. 

 

  Com base neste conjunto de dados, procedeu-se ao cálculo das áreas de 

desgaste de flanco das ferramentas de metal duro (classe K10) revestidas. A 

quantificação foi realizada comparativamente através dos três métodos propostos: 

manual, semiautomático e híbrido. 

 

4.2 METODOLOGIA  

 

4.2.1 Metodologias de análise com ImageJ (segmentação, medição de área, perfil de 

desgaste)   

O software ImageJ (versão 1.54t), de domínio público e utilizando a distribuição 

Fiji (Fiji Is Just ImageJ), foi empregado como plataforma principal para o 

processamento, segmentação e medição das áreas desgastadas. As três metodologias 

a seguir foram testadas, comparadas e avaliadas quanto à precisão, reprodutibilidade e 

praticidade de execução.  

Para download do software utilizado e fins de reprodutibilidade dos resultados, o 

pacote Fiji está disponível em: https://imagej.net/software/fiji/downloads. 

 

4.2.2 Metodologia 1: Medição Manual-Digital (Contorno Livre "Freehand") 
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A primeira metodologia utilizou o modo manual-digital, no qual o operador realiza 

o contorno da área desgastada diretamente na imagem, usando a ferramenta Freehand 

Selection. Embora simples, o método permite compreender a estrutura básica de 

calibração e medição do ImageJ. 

Procedimento: 

• Execute o ImageJ.  

Abertura da Imagem: Abrir o arquivo .tif (ex: T1 - 70x - 3D.tif, ver figura 10) no 

ImageJ (File > Open...). E busque a foto a ser analisada. 

 

Figura 10 Abertura da imagem a ser analisada 

 

Fonte: Autor (2025) 
 

Calibração Manual: Utilizar a ferramenta "Linha Reta" para medir a barra de 

escala gráfica (ex: "200 micrômetros") em pixels. Em seguida, usar Analyze > Set 

Scale... para informar ao software a "distância conhecida" (200) e a "unidade" (μm) (ver 

figura 11) 
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Figura 11 Calibração manual da imagem no ImageJ 

 

Fonte: Autor (2025) 

 

Seleção Manual: Utilizar a ferramenta "Freehand Selections" (Seleção Livre) 

para desenhar manualmente o contorno da área de desgaste (Figura 12). 

Medição:  

• Executar Analyze > Measure (Atalho: Ctrl + M) para obter a área em 𝜇𝑚2 

na janela de "Resultados" (Figura 13). 

Figura 12 Segmentação manual da área de desgaste usando "Freehand Selection" 

 

Fonte: Autor (2025) 
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Figura 13 Tabela de resultados da medição de área via Freehand 

 

Fonte: Autor (2025) 

 

Limitações Identificadas: Embora este método meça a área, ele sofre de alta 

subjetividade. O traçado com o mouse não é perfeitamente repetível. Duas medições 

na mesma imagem produzem resultados ligeiramente diferentes, dependendo da 

firmeza da mão do operador. 

 

4.2.3 Metodologia 2: Medição Semiautomática (Limiarização "Threshold”) por 

Isolamento de Máscara e Análise de Partículas   

 

Utilizado para isolar e quantificar com precisão o desgaste de flanco em 

ferramentas de corte, garantindo que cada tipo seja medido individualmente. 

O processo foi executado separadamente para cada tipo de desgaste em todas 

as imagens analisadas. 

Etapa 1: Abertura e Calibração Manual (Garantindo a Precisão) 

O primeiro passo é abrir a imagem e forçar uma calibração manual precisa, já 

que a calibração automática pode não ser confiável. 

Abrir a Imagem: 

• Ir a File > Open... 

Versão Final Homologada
10/02/2026 15:14



 

25 

 

• Selecione o arquivo da amostra (exemplo: T1 - 70x.tif). 

• Selecionar a Ferramenta de Linha: 

• Clique na ferramenta “Line” (Linha Reta). 

• Medir a Barra de Escala: Localize a barra de escala (exemplo: 200 µm) e meça 

com a ferramenta de linha. (Figura 14). 

Figura 14 Medição manual da barra de escala para calibração da imagem 

 

Fonte: Autor (2025) 

 

Definir a Escala (Set Scale): (Figura 15). 

• Vá em Analyze > Set Scale...  

• Known distance: 200 

• Unit of length: µm 

• Marque Global e clique em OK. 
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Figura 15 Configuração manual da escala de calibração (200 µm) 

 

Fonte: Autor (2025) 

 

Etapa 2: Isolamento da Região de Interesse (ROI)  

Selecionar a Ferramenta Polígono: 

• Clique em “Polygon Selections”.Traçar o Contorno Manual: 

• Clique cuidadosamente ao redor da região de desgaste de flanco 

(Figura 16) e feche o polígono. 
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Figura 16 Delimitação manual da região de interesse correspondente ao desgaste de flanco 

 

Fonte: Autor (2025) 

 

Etapa 3: Criação da Máscara (Etapa Chave) (Figura 17). 

Criar a Máscara: 

• Com a seleção ativa, vá em Edit > Selection > Create Mask. 

Figura 17 Criação da máscara binária a partir da seleção poligonal 

 

Fonte: Autor (2025) 
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Analisar a Nova Imagem: 

• O ImageJ criará a janela “Mask” em preto e branco (branco = desgaste, preto = 

fundo). Conforme ilustrado na Figura 18. 

Figura 18 Máscara binária gerada a partir da seleção da região de desgaste de flanco 

 

Fonte: Autor (2025) 

 

Etapa 4: Segmentação por Limiarização (Threshold) 

Ativar o Threshold: 

• Na janela “Mask”, vá em Image > Adjust > Threshold... (ou Ctrl+Shift+T). 

Ativar o Threshold: 

• Ajustar os Limites: 

Ajuste os controles até que o desgaste fique em vermelho e o fundo em preto. A 

Figura 19 demonstra a janela de "Threshold" sendo ajustada para isolar a máscara. 
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Figura 19 Ajuste manual do limiar para segmentação da região de desgaste 

 

Fonte: Autor (2025) 

 

Etapa 5: Medição por Análise de Partículas 

Abrir a Análise de Partículas: 

• Vá a Analyze > Analyze Particles... Na Figura 20, é possível observar o menu 

sendo selecionado para acessar o módulo de medição. 

Figura 20 Acesso ao módulo Analyze Particles para medição da área segmentada 

 

Fonte: Autor (2025) 
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Configurar a Análise: 

Marque as seguintes opções, conforme apresentado na Figura 21: 

      Display Results 

      Clear Results 

      Summarise 

Figura 21 Configurações adequadas para análise de partículas no ImageJ 

 

Fonte: Autor (2025) 

 

Obter o Resultado: 

• Clique em OK para visualizar as janelas "Results" e "Summary". A Figura 22 

apresenta a tabela "Summary" , que exibe o valor final da "Total Area" calculada. 
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Figura 22 Resultado da análise de partículas com a área do desgaste (µm²) 

 

Fonte: Autor (2025) 

 

Recomendações Finais 

• Salve todas as máscaras geradas (File > Save As...) para manter rastreabilidade. 

• Ajuste brilho e contraste antes do Threshold se o contraste for baixo. 

- Mantenha consistência entre as imagens (mesma ampliação e iluminação). 

- Registre os valores obtidos em uma planilha (Excel ou CSV) para comparação 

posterior.  

• Vantagens: O método semiautomático reduz a interferência humana e garante 

resultados precisos e reprodutíveis. Limitação: Ainda requer a seleção inicial 

manual das regiões (ROI). 

 

4.2.4 Metodologia 3: Medição híbrida, uso dos métodos manual, threshold e 

Script/Macro no ImageJ 

Com base nos resultados anteriores, foi desenvolvido um script (macro) no 

ImageJ com o objetivo de automatizar as etapas de medição e padronizar o processo. 

O script (analisardesgaste.ijm) foi desenvolvido através de uma metodologia híbrida, 

combinando o planejamento lógico próprio com ferramentas de geração de código 
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assistidas por Inteligência Artificial (IA). O processo foi estruturado da seguinte forma: 

Definição da Lógica e dos Requisitos: Primeiramente, definiu-se todo o fluxo de 

trabalho lógico necessário. Para isso, decompôs-se o procedimento manual (Seção 

4.2.3) em uma sequência exata de comandos e interações que o operador precisaria 

realizar, como exibir instruções, pausar para a seleção de ROI, pausar para o ajuste de 

threshold, etc. 

➢ Geração Assistida de Código: Para cada etapa lógica definida, utilizou-se uma 

ferramenta de IA (ChatGPT) como assistente de programação. Foram fornecidos 

os requisitos da etapa (por exemplo: "Preciso de um comando que pause o script 

e mostre a mensagem 'Desenhe o Flanco'") e a IA auxiliou na elaboração do 

bloco de código correspondente na linguagem de macro do ImageJ. 

➢ Validação, Depuração e Integração: Esta foi a etapa mais crítica. O código 

gerado pela IA não foi implementado diretamente. Cada bloco de código foi 

minuciosamente revisado, testado e "depurado" (corrigido) em um ambiente de 

testes no ImageJ. Isso foi feito para garantir que o código executava a ação 

desejada de forma correta e precisa. 

➢ Refinamento Iterativo: Após a validação dos blocos de código individuais, os 

mesmos foram integrados ao script principal. O script completo passou por 

múltiplos ciclos de testes e refinamentos (análises iterativas) realizados para 

assegurar que o fluxo de trabalho era robusto, que as variáveis eram capturadas 

corretamente e que a interação com o operador era clara. 

Esta abordagem permitiu o foco na lógica metodológica e na validação dos 

resultados, enquanto utilizou-se a IA como uma ferramenta para acelerar a elaboração 

da sintaxe do código. 

Procedimento detalhado (Fluxo do Script analisar desgaste) o qual é executado 

para cada imagem de micrografia calibrada: 

• Execução e Preparação: O script é iniciado (Plugins > Macros > Run...). 

Conforme ilustrado na Figura 23, primeiro prepara-se o ambiente, limpando 

quaisquer resultados ou janelas de processos anteriores (Clear Results, Close 

"Mask", etc.). 
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Figura 23 Execução e preparação do script 

 

Fonte: Autor (2025) 

 

Etapa 1: Entrada do Operador (Seleção de ROIs): O script pausa e solicita 

ativamente a intervenção do operador para a tarefa de interpretação espacial, como 

pode ser visto na Figura 24. 

Figura 24 Entrada do operador (Seleção de ROIs) 

 

Fonte: Autor (2025) 

 

 

Passo 1.1 (Flanco): Uma caixa de diálogo (waitForUser) instrui o operador a usar 
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a ferramenta "Polygon Selections" para contornar a área de desgaste de flanco (ver 

Figura 25). O operador então pressiona a tecla 't' para adicionar esta seleção (ROI) ao 

"ROI Manager". 

Figura 25 Ferramenta Polygon Selections 

 

Fonte: Autor (2025) 

 

Etapa 2: Processamento e Medição (Automação do Script): Após o operador 

confirmar que o ROI foi criado, o script assume o controle total e inicia o processamento 

automático, executando o seguinte ciclo duas vezes (uma para cada ROI): 

Passo 2.1 (Isolamento): O script seleciona o primeiro ROI (Flanco) e executa o 

comando run("Create Mask"). Isso cria uma nova imagem "Mask" contendo apenas a 

área de flanco, eliminando qualquer interferência da cratera. 

Passo 2.2 (Limiarização Visual): O script executa run ("Threshold..."), 

abrindo a janela de Limiarização. A Figura 26 detalha ele como pausa (waitForUser) e 

instrui o operador a ajustar visualmente os controles deslizantes até que a máscara 

vermelha cubra perfeitamente a área de desgaste. 

Versão Final Homologada
10/02/2026 15:14



 

35 

 

Figura 26 Ajuste visual dos controles deslizantes 

 

Fonte: Autor (2025) 

 

 

Passo 2.3 (Cálculo): Após o operador dar "OK", o script captura os valores de 

threshold (getThreshold), converte a máscara (Convert to Mask) e executa a análise de 

partículas (Analyze Particles...). 

Passo 2.4 (Coleta de Dados): O script lê a tabela de resultados (nResults), 

identifica a coluna de área (ex: "Area") e soma (getResult) todos os fragmentos 

encontrados para calcular a área total daquele desgaste. 

Etapa 3: Apresentação dos Resultados: Ao final do processo, o script fecha todas 

as janelas auxiliares (ROI Manager, Mask) e apresenta ao operador uma caixa de diálogo 

final (showMessage). A Figura 27 apresenta um exemplo desta janela com o resumo dos 

dados, contendo as áreas totais calculadas para Flanco e Cratera, que também são 

salvas na janela "Log" para registro. 
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Figura 27 Apresentação dos resultados pelo script 

 

Fonte: Autor (2025) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Versão Final Homologada
10/02/2026 15:14



 

37 

 

5. RESULTADOS E DISCUSSÃO 

5.1 QUANTIFIAÇÃO DAS ÁREAS DESGASTADAS 

 

Para avaliar a influência do teor de alumínio na resistência ao desgaste das 

ferramentas revestidas (CrAlN AA e CrAlN BA), adotou-se uma metodologia sistemática 

de análise via Processamento Digital de Imagens (PDI). O objetivo desta etapa foi 

transformar a análise visual qualitativa em dados quantitativos precisos, permitindo uma 

comparação estatística do desempenho entre os dois materiais. 

As imagens de Microscopia Eletrônica de Varredura (MEV) utilizadas como base 

para esta análise foram extraídas dos ensaios experimentais apresentados no relatório 

de pós-doutorado de (ÁVILA, 2011). Estas micrografias documentam a face de folga 

das ferramentas após intervalos de usinagem efetiva de 2, 4, 6 e 8 minutos.  

A análise comparativa realizada neste trabalho foi viabilizada pela padronização 

dos parâmetros de aquisição no MEV: tensão de aceleração de 20 kV, aumento de 70X 

e escala gráfica de 200 μm. Essa uniformidade assegurou que as dimensões da região 

de desgaste de flanco fossem diretamente comparáveis entre as diferentes amostras e 

tempos de usinagem, eliminando a necessidade de ajustes de escala durante o 

processamento das imagens. 

 

5.2 TABELAS E GRÁFICOS COM DADOS DE ÁREA 

Os dados foram compilados após a realização das medições nas micrografias de 

ambos os revestimentos em todos os tempos de corte. As tabelas 3 e 4 apresentam os 

valores de área desgastada obtidos (mm2), discriminando os resultados por tempo de 

usinagem e pelo método de medição empregado. 

 

 

 

 

 

Versão Final Homologada
10/02/2026 15:14



 

38 

 

Tabela 3 Valores de área (mm2) obtidos pelos três métodos de medição para o revestimento CrAIN AA 

Tempo 
(min) 

Revestimento Teor de 
Al 

Espessura (μm) Método Área 
(mm2) 

2 CrAlN AA 0,68 1,98 Manual 0,2193 

4 CrAlN AA 0,68 1,98 Manual 0,2990 

6 CrAlN AA 0,68 1,98 Manual 0,3731 

8 CrAlN AA 0,68 1,98 Manual 0,4302 

2 CrAlN AA 0,68 1,98 Thresholds 0,2157 

4 CrAlN AA 0,68 1,98 Thresholds 0,2998 

6 CrAlN AA 0,68 1,98 Thresholds 0,3779 

8 CrAlN AA 0,68 1,98 Thresholds 0,4360 

2 CrAlN AA 0,68 1,98 Híbrido 0,2252 

4 CrAlN AA 0,68 1,98 Híbrido 0,3019 

6 CrAlN AA 0,68 1,98 Híbrido 0,3754 

8 CrAlN AA 0,68 1,98 Híbrido 0,4416 

Fonte: Autor (2025) 

 

Tabela 4 Valores de área (mm2) obtidos pelos três métodos de medição para o revestimento CrAIN BA 

Tempo 
(min) 

Revestimento Teor de 
Al 

Espessura (μm) Método Área (mm2) 

2 CrAlN BA 0,25 2,5 Manual 0,2213 

4 CrAlN BA 0,25 2,5 Manual 0,2429 

6 CrAlN BA 0,25 2,5 Manual 0,3427 

8 CrAlN BA 0,25 2,5 Manual 0,4403 

2 CrAlN BA 0,25 2,5 Thresholds 0,2114 

4 CrAlN BA 0,25 2,5 Thresholds 0,2782 

6 CrAlN BA 0,25 2,5 Thresholds 0,4010 

8 CrAlN BA 0,25 2,5 Thresholds 0,4841 

2 CrAlN BA 0,25 2,5 Híbrido 0,2279 

4 CrAlN BA 0,25 2,5 Híbrido 0,2792 

6 CrAlN BA 0,25 2,5 Híbrido 0,4029 

8 CrAlN BA 0,25 2,5 Híbrido 0,4830 

Fonte: Autor (2025) 

 

A partir dos dados tabulados, foram gerados gráficos comparativos para 

visualizar a cinética do desgaste e validar a confiabilidade da metodologia de medição. 

 

Análise via Método Manual 

Inicialmente, a Figura 28 apresenta a comparação da evolução da área de 

desgaste realizada através da medição manual. Conforme descrito na metodologia, 

este processo utilizou a ferramenta Freehand Selection (Seleção Livre), onde o 
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operador desenha o contorno da área desgastada diretamente sobre a imagem 

calibrada com base em sua percepção visual. 

Observa-se que, sob a análise manual, os valores finais de área para ambos os 

revestimentos são próximos. O CrAlN BA atingiu 0,4403 mm2 aos 8 minutos, valor 

ligeiramente superior ao do CrAlN AA (0,4302 mm2). 

Figura 28 Comparação da evolução da área de desgaste de flanco entre CrAIN AA e CrAIN BA Método 
Manual 

 

Fonte: Autor (2025) 

 

Análise via Método Semiautomático Limiarização (Thresholds) Para confirmar 

essa tendência de forma semiautomática, a Figura 29 exibe os dados obtidos 

exclusivamente pelo algoritmo de Thresholding. Os resultados corroboram a análise 

anterior.  

O método semiautomático também identificou o CrAlN-BA (barra laranja) como o 

material com maior desgaste acumulado ao final do ensaio. A inversão observada nos 

intervalos de 6 e 8 minutos, nos quais o CrAlN-BA apresentou maior área, pode ser 

atribuída ao fenômeno de adesão lateral (smearing).  

Ferramentas mais tenazes tendem a permitir maior acúmulo de material da peça 

(aresta postiça) sem fraturar; consequentemente, softwares de análise de imagem 

podem contabilizar esse acúmulo como área de desgaste na ausência de distinção de 
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cor, um fenômeno tribológico clássico descrito por Trent e Wright (2000). 

Figura 29 Comparação da evolução da área de desgaste de flanco entre CrAlN AA e CrAlN BA 

 

Fonte: Autor (2025) 

 

 

Análise via Método Híbrido  

Comparação de Desempenho (AA vs. BA). A Figura 30 ilustra a evolução da área 

de desgaste ao longo do tempo para ambos os revestimentos, utilizando os dados 

obtidos pelo Método Híbrido, considerados o mais representativo. 

Nota-se que, aos 8 minutos, o CrAlN-AA (barra azul) apresenta uma área de 

desgaste sensivelmente menor (0,4416 mm2) em comparação ao CrAlN-BA (0,4830 

mm2), indicando maior resistência nos estágios finais de corte onde a temperatura é 

mais elevada. 

Embora a tendência se mantenha, observa-se que a diferença entre as barras no 

tempo de 8 minutos é ligeiramente menor neste método, sugerindo uma variação na 

percepção visual das bordas do desgaste, conforme discutido a seguir. 
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Figura 30 Comparação da evolução da área de desgaste de flanco entre CrAlN AA e CrAlN BA Método 
Híbrido 

 

Fonte: Autor (2025) 

 

Para validar os dados acima, analisou-se como cada método se comportou para 

cada material especificamente. Consistência no CrAlN AA. A Figura 31 compara as três 

técnicas aplicadas ao revestimento CrAlN-AA. 

Figura 31 Gráfico comparativo entre os métodos de medição para CrAIN AA 

 

Fonte: Autor (2025) 
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Observa-se uma alta consistência entre os métodos. As três barras possuem 

alturas praticamente idênticas em todos os tempos. Isso indica que o desgaste no 

CrAlN-AA possui contornos bem definidos e limpos, permitindo medições precisas tanto 

por humanos quanto por software. 

Divergência no CrAlN BA. A Figura 32 revela um comportamento distinto para o 

revestimento CrAlN-BA.  

Observa-se uma divergência importante nos tempos de 6 e 8 minutos: 

Figura 32 Divergência entre métodos de medição para o CrAIN BA 

 

Fonte: Autor (2025) 

 

O Método Manual (barra azul) apresentou valores inferiores aos obtidos pelos 

métodos Semiautomático (Threshold) e Híbrido. A princípio, essa diferença poderia 

sugerir que o operador, ao visualizar a área, define a região de desgaste com maior 

seletividade do que o software.  

Entretanto, deve-se considerar que os métodos computacionais utilizam o 

contraste matemático dos pixels para a definição da área, o que lhes permitiu detectar 

regiões de desgaste que passaram despercebidas na seleção manual. Assim, neste 

caso específico, os métodos automatizados mostraram-se referências robustas. A 
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explicação física para essa discrepância reside na morfologia do desgaste do 

revestimento CrAlN-BA.  

Conforme observado por Sousa et al. (2021), o desgaste em revestimentos 

menos estáveis é frequentemente acompanhado por fenômenos de intensa adesão do 

material da peça sobre a ferramenta. Essa adesão cria bordas irregulares e camufla a 

fronteira real do desgaste, dificultando a medição visual (manual), mas sendo captada 

pela sensibilidade dos algoritmos de processamento de imagem. 

 

5.3 RELAÇÃO COM OS MECANISMOS DE DESGASTE NA LITERATURA 

Os resultados obtidos mostram coerência com os mecanismos de desgaste 

descritos na literatura para revestimentos CrAlN submetidos a condições severas de 

corte. A diferença de desempenho entre CrAlN-AA e CrAlN-BA, especialmente no tempo 

de 8 minutos, pode estar associada aos fenômenos termoquímicos que ocorrem na 

interface ferramenta–cavaco. 

 

• Resistência à Oxidação e Formação de Tribocamada 

Estudos de Arulkirubakaran e Senthilkumar (2016) demonstram que 

revestimentos enriquecidos em alumínio tendem a formar óxidos estáveis, como Al₂O₃, 

que atuam como barreira térmica e reduzem o atrito. Embora não tenham sido 

realizadas análises químicas neste trabalho (como EDS ou XPS), o comportamento 

observado no CrAlN-AA menor área desgastada no maior tempo de corte é consistente 

com a formação parcial de uma tribocamada protetora rica em alumínio, o que poderia 

retardar mecanismos abrasivos e difusivos.  

Por outro lado, o CrAlN-BA, por possuir menor teor de alumínio, tende a formar 

óxidos menos estáveis, o que reduz sua proteção tribológica em condições de maior 

temperatura. Esse efeito ajuda a explicar o aumento mais acentuado da área 

desgastada para o BA aos 8 minutos. 

 

• Ciclo de Adesão e Desgaste Difusivo 

A análise visual das micrografias e a dificuldade de segmentação no método 

manual para o CrAlN-BA sugerem a ocorrência de um ciclo mais severo de desgaste, 
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composto por adesão inicial do material da peça, seguida por abrasão e delaminação 

do revestimento, mecanismo descrito por Sousa et al. (2021).  

O maior acúmulo de material aderido ao CrAlN-BA, observado nas micrografias, 

reforça essa hipótese e explica as bordas irregulares da região desgastada, que 

dificultaram a seleção manual da ROI. 

 

• Influência da difusão em altas temperaturas 

Saketi et al. (2019) relatam que, em condições de elevada temperatura e 

velocidades moderadas, o desgaste pode ser governado pela difusão de elementos da 

ferramenta para o cavaco. No presente trabalho, embora não se possa afirmar difusão 

química direta sem análise composicional, a maior extensão da área degradada no 

CrAlN-BA sugere maior susceptibilidade a processos triboquímicos, possivelmente 

devido à ausência de uma tribocamada protetora mais estável. Já o CrAlN-AA, 

potencialmente protegido por uma camada rica em Al₂O₃, apresentou comportamento 

mais estável no maior tempo de usinagem, o que é coerente com a literatura. 
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6. CONCLUSÕES 

O presente trabalho desenvolveu e aplicou um método de quantificação de 

desgaste baseado em análise digital de imagens no software ImageJ, permitindo 

mensurar de forma objetiva a área de desgaste no flanco de ferramentas revestidas 

submetidas ao torneamento do ferro fundido nodular FE45012. A metodologia mostrou-

se eficiente, reprodutível e capaz de revelar diferenças importantes entre os 

revestimentos CrAlN-AA e CrAlN-BA.  

A análise comparativa entre os métodos manual, semiautomático e híbrido 

demonstrou que o método híbrido é o mais confiável, pois combina a precisão da 

limiarização automática com a sensibilidade visual do operador. As tendências de 

desgaste obtidas foram coerentes com a evolução esperada para ferramentas 

revestidas em condições severas de corte.  

Os resultados também evidenciaram que a métrica de área total desgastada 

fornece informações complementares às obtidas pela métrica linear VB, utilizada no 

estudo de Ávila (2011). Embora esse autor tenha observado melhor desempenho do 

revestimento CrAlN-BA pela medida linear de desgaste, o presente trabalho mostrou 

que, quando avaliada a área degradada, o revestimento CrAlN-AA apresentou 

estabilidade superior no maior tempo de corte. Essa diferença é consequência direta 

das métricas analisadas e não representa contradição, mas sim ampliação da 

compreensão do desgaste nos revestimentos CrAlN.  

Assim, conclui-se que a quantificação por área é uma ferramenta robusta e 

capaz de complementar métodos tradicionais de medição, ampliando a capacidade de 

avaliar a morfologia e a evolução dos mecanismos de desgaste em ferramentas de 

corte revestidas. 

 

6.1 PRINCIPAIS ACHADOS DO ESTUDO  

A metodologia baseada no ImageJ foi eficiente para segmentar e quantificar a 

área de desgaste de flanco, proporcionando medições objetivas e reprodutíveis. O 

método híbrido apresentou melhor desempenho entre os três avaliados, oferecendo 

equilíbrio entre precisão, sensibilidade morfológica e estabilidade dos resultados.  

Observou-se crescimento progressivo da área desgastada com o aumento do 
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tempo de usinagem, comportamento compatível com os mecanismos esperados de 

desgaste abrasivo, adesivo e oxidativo. Em diversos tempos de corte, o revestimento 

CrAlN-BA apresentou áreas desgastadas ligeiramente maiores que o CrAlN-AA, 

especialmente em tempos mais longos.  

Essa diferença pode estar associada à ausência de uma tribocamada rica em 

alumínio no CrAlN-BA, contribuindo para maior adesão e instabilidade térmica no 

desgaste prolongado. Os resultados apresentam complementação ao estudo de Ávila 

(2011): enquanto VB indicou melhor desempenho do CrAlN-BA, a métrica de área deste 

estudo revelou diferenças morfológicas importantes que não apareciam na métrica 

linear. 

 

6.2 CONTRIBUIÇÕES PARA O ENTENDIMENTO DO DESGASTE EN FERRAMENTAS 

DE CORTE 

 

O estudo demonstrou que diferentes métricas de desgaste (área versus VB) 

podem conduzir a interpretações distintas sobre desempenho dos revestimentos, 

destacando a importância de análises multidimensionais.  

A quantificação por área permitiu identificar aspetos morfológicos do desgaste 

como adesão, de laminação, microtrincas e irregularidades que não são capturados 

pela medida VB.  

O trabalho contribui para ampliar o entendimento do comportamento 

termoquímico de revestimentos CrAlN com diferentes teores de alumínio, mostrando 

como a formação (ou ausência) de tribocamadas protetora influência a área degradada.  

A aplicação de processamento digital de imagens mostrou-se promissora como 

ferramenta complementar aos métodos tradicionais, podendo ser adotada em estudos 

futuros de usinagem e tribologia. O conjunto de resultados reforça que revestimentos de 

alto alumínio podem apresentar maior estabilidade em regimes prolongados devido à 

possível formação de camadas protetoras de óxidos, alinhando o comportamento 

observado à literatura recente. 
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6.3 SUGESTÕES PARA TRABALHOS FUTUROS 

Aperfeiçoamento do método: Desenvolver uma interface gráfica (GUI) integrada 

ao ImageJ, permitindo a execução da macro de forma mais intuitiva, padronizada e 

acessível para laboratórios de ensino e pesquisa.  

Integrar ao método a possibilidade de processamento automático em lote, 

reduzindo o tempo de análise e aumentando a reprodutibilidade.  

Ampliação das análises: Incluir a quantificação da área de desgaste de cratera, 

possibilitando correlações mais completas entre desgaste frontal e desgaste superior.  

Realizar análises químicas (EDS, XPS, micro-Raman) para confirmar a formação 

de tribocamadas ricas em alumínio ou cromo, correlacionando composição química e 

morfologia do desgaste.  

Correlação com métricas tradicionais: Realizar medições simultâneas de VB e 

área desgastada em condições idênticas, a fim de construir modelos matemáticos de 

correlação entre essas métricas.  

Comparar o método de área com técnicas volumétricas 3D (interferometria, 

confocal) para quantificar o volume perdido e evoluir para análises tridimensionais do 

desgaste.  

Aplicações práticas: Avaliar o comportamento de outros revestimentos PVD 

(TiAlN, AlTiN, AlCrN, multicamadas e nanocompósitos), ampliando o escopo 

comparativo.  

Investigar diferentes condições de corte (velocidade, avanço, profundidade) para 

mapear o impacto dos parâmetros na evolução da área degradada. 
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